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Introduction 

You purchased Bluespring Software’s BPM5, an innovative version of Business Process Management 

(BPM) software which will allow your company to effectively reduce cost, increase customer 

responsiveness, ensure quality, maintain compliance, and manage growth with proven success. 

Bluespring Software has acted as a supplement to an array of companies’ business processes since 1998. 

This guide will lead you through the installation of the various BPM5 Services. If you have questions 

about the installation, please contact Bluespring Support by email at support@bluespring.com or by 

phone at (877) 871-9566. 

The following services and applications will be installed upon the completion of the steps in this guide:  

 BPM Workspace Service 

 BPM Task Service 

 BPM Notification Service 

 BPM Scheduling Service 

 BPM Process Engine Service 

 BPM File Monitor Service (optional) 

 BPM SharePoint Service (optional) 

 BPM CRM Service (optional) 

 BPM CRM 2011 Service (optional) 

 BPM Designer 5 

 BPM Admin 5 

 BPM Command Service 

BPM5 Capabilities 

You can use BPM5 to perform a series of automated and managed tasks as part of your business 

processes. Key capabilities include: 

 Collaborative definition and deployment of process solutions that span any combination of 

people, systems, data sources, locations, and organizational entities.  

 Improved utilization of Microsoft investment (SharePoint, Dynamics, Exchange, etc). 

 Ability for you to control your existing IT assets, including systems, data sources, and 

documents, within any business process, through standards-based integration methods.  

 Management of steps that require human interaction for the completion of a task.  

 Operation as a non-intrusive service within your existing infrastructure to drive highly 

consistent, reliable, scalable, and dynamic automated processes.  

 Presentation of tools which will allow you to effectively monitor and manage the operating 

process on a real-time basis.  
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 Ability to report in real-time how a business process is performing and make decisions that 

positively impact your bottom line. 

BPM5 Architecture 

                                                            

            

 

                             

 

 

 

 

 

 

 

 

 

 

 

BPM5 will run against one Workspace which supports multiple run-time environments.  

The number of run-time environments you create will support your process development lifecycle. 

Development lifecycles may vary and BPM5 is designed to support agile and waterfall approaches to 

process development. 
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Hardware and Software Requirements 

Verify that the server(s) you have designated for Bluespring BPM5 meet the following hardware and 

software requirements. 

Hardware Software 

 

 32-bit or 64-bit 

 CPU > 2.2 GHz (Dual or Quad Core 
recommended, depending upon volume 
projections) 

 4 GB RAM 

 10 GB usable disk space (additional 
storage for databases required) 

 100BaseTX Ethernet Network Adapter 
(Gigabit Ethernet recommended) 

 Separate Hardware RAID 10 volumes are 
recommended for database data, index, 
and log files (when used in production 
environment) 

 

 

 Services require one of the following: 
Windows Server 2008 
Windows Server 2008 R2 

 Designer and Admin support: 
Windows XP 
Windows Vista 
Windows 7 

 Message Queuing Component/Feature^ 

 .NET Framework 4.0* 

 Windows Identity Foundation* 

 SMTP-compliant server in the enterprise 

 Database server with one of the following: 
Microsoft SQL Server 2008 Standard 
Microsoft SQL Server 2008 Enterprise 
Microsoft SQL Server 2008 R2 Standard 
Microsoft SQL Server 2008 R2 Enterprise 
Microsoft SQL Server 2012 Standard 
Microsoft SQL Server 2012 Enterprise 

*   These files can be downloaded for free from Microsoft’s web site (www.microsoft.com). 

ˆ Only required on the server hosting the Process Engine service. For Server 2003, you only need to 

select the Common subcomponent of the Message Queuing component. For Server2008, you only need 

to select the Message Queuing Server service of the Message Queuing feature. 

Bluespring recommends that BPM5 be installed on a minimum of two servers to get started. Additional 

Workspace and Runtime servers may be required to support your process development lifecycle. 

Workspace and Runtime Server 

This server hosts the Workspace, Process Engine, Task, Notification, Scheduling and other 

runtime services for a single runtime environment. The first runtime environment will likely be 

your “development” runtime environment. You can then stand up subsequent runtime 

environments (additional servers) to support testing, staging, and production environments. 
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Bluespring Support Policy 

Bluespring Software is committed to providing you with the best overall product experience. Our 

products are designed with superior quality and ease of use in mind, but we understand that issues do 

arise from time to time that need the backing of our support resources. 

For more information, please contact Bluespring Software’s Customer Support Operations at (877) 871-

9566. 

Bluespring support services are subject to the prices, terms, and conditions in place at the time the 

services are used. 

Contact Information 

Address:  10290 Alliance Road 
Cincinnati, Ohio 

45242 

Telephone:  (513) 794-1764 (Cincinnati) 
(877) 871-9566 (Toll Free) 

Fax:   (513) 794-1724 

WWW:  www.bluespring.com 
  www.bluespringsoftware.com 
  www.bluespringonline.com 
 
Email:   support@bluespring.com 

Office hours:  Monday to Friday 
8:00 A.M. to 5:00 P.M. Eastern Time 

  

http://www.bluespringonline.com/
http://www.bluespringonline.com/


 

 

7   

Installing BPM Workspace Service 

The BPM Workspace Service manages communication between the BPM5 services, the BPM5 Workspace 

Database, and the BPM5 Runtime Databases. 

To install the BPM Workspace Service, complete the following steps: 

1. Double-click the BPM Workspace setup file (bpm workspace.msi). The BPM Workspace 5 Setup 

Wizard is displayed. 

Note:  If you encounter an error during the install, please retry the install, but double-

click the bpm workspace.bat file to start the install. Using that file will generate 

a detailed installation log file. You can send this log file to Bluespring Support for 

assistance. 
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2. Click Next. The End-User License Agreement screen is displayed

 
3. After reading the agreement, select the I accept the terms in the License Agreement checkbox. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Workspace Service files. 

5. Click Next. The HTTP Server screen is displayed. 

 
 

6. In the Hostname field, type the name of the host server. 

Note: Bluespring recommends using the server’s Fully Qualified Domain Name 

(FQDN). If you do not know the server’s FQDN, please contact your IT 

department.  
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For example, if your domain is called domain.net and the server name is BPM, 

then the FQDN would be bpm.domain.net. 

7. In the Server Details fields: 
a. Type the port number in the Port number field. The Workspace Service will listen for 

requests on this port. 

Note:  Port 9000 is the default port used by BPM 5’s services; however, you can change 

the port number if port 9000 is used by another application. 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data. 

Note:  Using HTTPS requires additional system configuration for security certificates. 

Please contact Bluespring Support if interested in using HTTPS. 

8. Click Next. The SQL Server screen is displayed. 

 
9. In the SQL Server Name field, type the name of your Microsoft SQL Server 2005/2008 server and 

SQL instance, if applicable. 

Note:  The SQL Server instance must be configured to use mixed mode authentication, 

so it can support SQL logins. 

10. From the Login Credentials fields, select the required authentication type. 

Note:  Windows Authentication will use the account of the Windows user performing 

the install. If that user does not have System Administrator (sysadmin) 

permissions to the server, then select the SQL Authentication option and enter 

the credentials of a SQL login account. This account is used only while creating 

the Workspace database and, if necessary, SQL logins. 

11. Click Next. The Workspace Database screen is displayed. 
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12. In the Database Name field, type a name for your Workspace database. 

13. In the SQL Login for Workspace Service fields, click Create New. The Create SQL Login window is 

displayed. 

Note:  If you have a SQL Login, type that user name and password in the respective 

fields and skip to step 15. The account will be added to a new SQL role called 

Bluespring.  

 You type the credentials for a new SQL user account used by the Workspace 

Service to connect to the Workspace database. 

 
14. Complete the following fields: 

a. In the User name field, type the user name. 

b. In the Password field, type the user’s password. 

c. In the Confirm password field, retype the password. 

15. Click OK. You created a new SQL login for the Workspace service. 
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16. Click Next. The Client Login screen is displayed.

 
17. In the Login for BPM client applications fields, click Create New. The Create SQL Login window is 

displayed.  

This login will be used by BPM Designer clients to read and write information to the Workspace 

database.  

Note:  If you have a SQL Login, type that user name and password in the respective 

fields and skip to step 19. The Client SQL login is assigned lesser permissions 

than the Workspace Login. Bluespring recommends that you do not use the 

Workspace Login for the client login because of the security differences. 

 

18. Complete the following fields to create a new SQL login: 

a. In the User name field, type your user name. 

b. In the Password field, type your password. 

c. In the Confirm password field, retype the password. 

19. Click OK. You created a new login for BPM client applications. 
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20. Click Next. The Ready to install Bluespring BPM Workspace 5 screen is displayed.

 
21. Click Install. The installation begins. When complete, the Completed the Bluespring BPM 

Workspace 5 Setup Wizard screen is displayed. 

 
22. Click Finish. You installed the Bluespring BPM Workspace Service 5. 

Verifying the BPM Workspace Service 5 Installation 

Verify that your installation was successful by checking for errors in the service’s log file or by checking 

the service’s status in the Services utility or both. 

To check for errors in the Bluespring Workspace log file, complete the following steps: 
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1. Navigate to the Workspace Service folder. This is the folder you selected as the destination 

folder in step 4 of Installing the BPM Workspace Service. 

2. Open the Bluespring Workspace Service log file (Bluespring.WorkspaceService.log).  

You should not see any errors and see two lines similar to the following two lines: 

 2010-06-14 22:41:42  WorkspaceService running => 

http://bpm:9000/Bluespring/Workspace.ashx 

 2010-06-14 22:41:42 IWorkspaceHttpService running => http://bpm:9000/Bluespring 

To check the BPM Workspace Service installation status in the Services utility, complete the following 

steps: 

1. From the Start menu, select Administrative Tools and then select Services. 

2. In the Services window, select Bluespring Workspace Service. The status of the selected service 

is displayed as Started under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 

  

http://bpm:9000/Bluespring
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Creating a Runtime Database 

You need to create a runtime database for each BPM 5 Runtime environment. Typically, companies 

using BPM 5 will have three runtime environments, which are separate for Development, Testing, and 

Production.  

To create a BPM 5 Runtime database, complete the following steps: 

1. From the Start menu on the Workspace Service server, select All Programs > Accessories. 

2. Right-click Command Prompt. 

3. Select Run as administrator. The Administrator: Command Prompt window is displayed. 

Note: You do not need to complete steps one through three, if you are using Windows Server 

2003 or if your User Account Controls are disabled. 

 
 

4. Navigate to the bin folder in the BPM Workspace Destination folder. 

Note: This folder is the destination folder that you selected in Step 3 of the Installing 

the BPM Workspace Service steps. 

 

5. Enter the following command and any parameters as necessary: 

runtimedb add <runtime database name>  

Note:  The SQL Server instance must be configured to use mixed mode authentication, 

so that it can support SQL logins. 

 

The runtimedb command also supports the switches (or parameters) in the following table: 
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Switch Description 

-cu  

  

Existing SQL user account to be used as the BPM 5 runtime login. The 

default account is client_<WorkspaceDatabase> if empty. 

-cp  Existing SQL user’s password. Auto-generated if empty. 

-f  Package file. The default is RuntimeDB.sqlx. 

-nologo Prevents the display of logo information 

-s  SQL server and instance. The default is local, if empty. You must specify a 

value if the Workspace Server is not your SQL Server. 

-u  SQL user account used to create the runtime database and, if necessary, 

user. 

-p  SQL user’s password. 

-t Optional. SQL command timeout in seconds. 

 

6. Press the Enter key. The command starts executing. When complete, the Operation completed 

successfully message is displayed. 

 
7. Exit the command prompt. You created a runtime database.  

Note: You need to select this runtime database while installing the Process Engine 

Service, Task Service, Scheduling Service, and Notification Service. 
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Updating the SMTP Information Table in the Workspace Database 

You need to update the SMTP information table (SmtpInfo) after you have installed the BPM Workspace 

service and created the Runtime Database. You update this table, so the Notification Service knows 

which SMTP server to use when sending emails.  

Note:  These steps assume you have knowledge of Microsoft SQL Server Management 

Studio and have executed queries against Microsoft SQL Server databases. If 

you have questions, please contact your Microsoft SQL Server Database 

Administrator. 

 

To update the SMTP information table in the Workspace database, complete the following steps: 

1. Connect to the SQL server and instance hosting your Workspace database, using Microsoft SQL 

Server Management Studio.  

2. Select the following: 

a. From the Server type drop down list, the type of the server (e.g. Database Engine). 

b. From the Server name drop down list, the name of your SQL server. 

c. From the Authentication drop down list, the required authentication. 

3. Click Connect. The Microsoft SQL Server Management Studio window is displayed. 

4. On the toolbar, click New Query. 

5. Type the following query: 

DECLARE @RuntimeDatabase as varchar(500), 
 @SmtpServer as varchar(500), 
 @Port as integer 

 
SET @RuntimeDatabase = 'BpmRuntime' 
SET @SmtpServer = 'CompanySMTPServerName' 
 
SET @Port = 25 
DECLARE @EnvID as uniqueidentifier 
SET @EnvID = NULL 
 
SELECT TOP 1 @EnvID = [ID] 
FROM dbo.Environment 
WHERE [Name] = @RuntimeDatabase 
 
/* Returns the contents of SmtpInfo before any changes are made */ 
SELECT * FROM dbo.SmtpInfo 
 
IF @EnvID IS NOT NULL 
 IF 0 < (SELECT COUNT(*) FROM dbo.SmtpInfo WHERE EnvironmentID = @EnvID) 
  UPDATE dbo.SmtpInfo 
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  SET Host = @SmtpServer, 
   Port = @Port 
  WHERE EnvironmentID = @EnvID 
 ELSE 
  INSERT dbo.SmtpInfo (EnvironmentID, Host, Port, [Timeout]) 
  VALUES (@EnvID, @SmtpServer, @Port, 60000) 
ELSE 
 SELECT 'ERROR: No Environment ID was found for the Runtime DB: ' + 
ISNULL(@RuntimeDatabase, 'ERROR') 
 
/* Returns the contents of SmtpInfo after any changes are made */ 
SELECT * FROM dbo.SmtpInfo 

Note:  Replace the <SMTP Server> and <Runtime Database Name> placeholders with 

the name of your SMTP server and the name of your Runtime database, 

respectively. For information on the Host and the Port number, contact your IT 

department. 

 

The query sets the timeout to 1 minute, which is 60000 milliseconds. To change 

the timeout, modify the 60000 value before executing the query. You can later 

modify the value in the database to increase or decrease the timeout. 

 

6. Execute the query against your Workspace database. The corresponding ID, Environment ID, 

Host name, Port number, and Timeout are displayed in the Results tab. 

7. Exit the SQL Server Management Studio. You updated the SMTP Information table. 
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Installing BPM Task Service 

The BPM Task Service is a Windows service that manages the execution of process activities and the 

assignment of tasks to people in a process.  

To install the BPM Task Service, complete the following steps: 

1. Double-click the BPM task service setup file (bpm task service.msi). The Bluespring BPM Task 

Service 5 Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry the install, but double-

click the bpm task service (logfile).bat file to start the install. Using that file will 

generate a detailed installation log file. You can send this log file to Bluespring 

Support for assistance. 
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2. Click Next. The End-User License Agreement screen is displayed.

 
3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Task Service files. 

5. Click Next. The BPM Workspace screen is displayed. 

6. In the Workspace server name field, type the name of the server hosting your Workspace 

service. 

7. In the Port number field, type the Workspace Service’s Port Number. 

Note: The port number you enter here should be the same port number you entered on 

the HTTP Server screen in the Workspace Service install. 

8. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 

Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the Task service. 

Note:  By default, the Task Service will connect to the Workspace Service using the 

Local System account. The Local System account does not have permission to 

access the Workspace Service when it is hosted on a remote server. 
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9. Click Next. The Runtime Database screen is displayed.

 
10. From the Available runtime database(s) list, select the Runtime Database that you created in 

the section Creating a Runtime Database.  

11. Click Next. The HTTP Server screen is displayed. 

 
12. In the Hostname field, type the name of the host server. 

13. In the Server Details fields type the following details: 

a. Type the port number in the Port number field. The Task Service will listen for requests 

on this port. 
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Note: Port 9000 is the default port used by BPM 5’s services; however, you can change 

the port number if port 9000 is used by another application 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data. 

14. Click Next. The Ready to install Bluespring BPM Task Service 5 screen is displayed. 

 
15. Click Install. The Installation begins. When the installation is completed, the Completed the 

Bluespring BPM Task Service 5 Setup Wizard screen is displayed. 

 
16. Click Finish. You installed the Bluespring BPM Task Service 5. 
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Verifying the BPM Task Service 5 Installation 

Verify that your installation was successful by checking for errors in the service’s log file or by checking 

the service’s status in the Services utility or both.  

To check for errors in the Bluespring Task Service log file, complete the following steps: 

1. Navigate to the Task Service folder. This is the folder you selected as the destination folder in 

step 4 of Installing the BPM Task Service. 

2. Open the Bluespring Task Service log file (Bluespring.TaskService.log). 

You should not see any errors and the first three lines should be similar to the following lines: 

 2010-06-17 14:20:34  ITaskService stopped => http://bpm-

qa.qa.bluessw.net:9000/Bluespring/BpmRuntime/Tasks.ashx 

 2010-06-17 14:20:34  ITaskHttpService stopped => http://bpm-

qa.qa.bluessw.net:9000/Bluespring/BpmRuntime/tasks 

 2010-06-17 14:20:34  IEventCallback stopped => http://bpm-

qa.qa.bluessw.net:9000/Bluespring/BpmRuntime/Tasks/Callback.ashx 

To check the BPM Task Service installation status in the Services utility, complete the following steps: 

1. From the Start menu, select Administrative Tools and then select Services. 

2. In the Services window, select Bluespring Task Service. The status of the selected service is 

displayed as Started under the Status column 

  

http://bpm-qa.qa.bluessw.net:9000/Bluespring/BpmRuntime/Tasks/Callback.ashx
http://bpm-qa.qa.bluessw.net:9000/Bluespring/BpmRuntime/Tasks/Callback.ashx
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Installing BPM Notification Service 

The BPM Notification Service is used to send notifications to a user. For example, the Notification 

Service is used by the Send Email activity and by the activities that can send task notifications. 

Notifications can be sent when a task is assigned, escalated, reassigned, completed, timed out, or failed.   

To install the BPM Notification Service, complete the following steps: 

1. Double-click the BPM Notification Service setup file (bpm notification service.msi). The 

Bluespring BPM Notification Service 5 Setup wizard is displayed. 

Note:  If you encounter an error during the install, please retry, but double-click the 

bpm notification service (logfile).bat file to start the install. Using the install file 

will generate a detailed installation log file. You can send this log file to 

Bluespring Support for assistance. 
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2. Click Next. The End-User License Agreement screen is displayed.

 
3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Notification Service files. 

5. Click Next. The BPM Workspace screen is displayed. 

 
6. In the Workspace server name field, type the name of your workspace server. 

7. In the Port number field, type the Workspace Service’s Port Number. 

Note:  The port number you enter here should be the same port number you entered 

on the HTTP Server screen in the Workspace Service install. 
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8. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 

Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the Notification service. 

Note:  By default, the Notification service will connect to the Workspace Service using 

the Local System account. The Local System account does not have permission 

to access the Workspace Service when it is hosted on a remote server.   

9. Click Next. The Runtime Database screen is displayed. 

 
10. From the Available runtime database(s) list, select the Runtime Database that you created in 

the section Creating a Runtime Database.  
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11. Click Next. The HTTP Server screen is displayed.

 
12. In the Hostname field, type the name of the host server. 

13. In the Server Details fields type the following: 

a. The port number in the Port number field. The Notification Service will listen for 

requests on this port. 

Note:  Port 9000 is the default port used by BPM 5’s services; however, you can change 

the port number if port 9000 is used by another application. 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data. 
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14. Click Next. The Ready to install Bluespring BPM Notification Service 5 screen is displayed.

 
15. Click Install. The installation begins. When complete, the Completed the Bluespring BPM 

Notification Service 5 Setup Wizard screen is displayed. 

 
16. Click Finish. You installed the Bluespring BPM Notification Service 5. 

Verifying the BPM Notification Service 5 Installation 

Verify that your installation was successful by checking for errors in the service’s log file or by checking 

the service’s status in the Services utility or both.  

To check for errors in the Bluespring Notification Service log file, complete the following steps: 
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To check the installation status in the Services utility, complete the following steps: 

1. From the Start menu, select Administrative Tools. 

2. Select Services. The Services window is displayed. 

3. Select Bluespring Notification Service. The status of the selected service is displayed as Started 

under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 
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Installing BPM Scheduling Service 

The BPM Scheduling service manages the starting of processes configured to use the Scheduled Start 

and any process delays configured in the Delay Process activity.  

To install the BPM Scheduling Service, complete the following steps: 

1. Double-click the BPM Scheduling Service setup file (bpm scheduling service.msi). The Bluespring 

BPM Scheduling Service 5 Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry, but double-click the 

bpm scheduling service (logfile).bat file to start the install. Using the install file 

will generate a detailed installation log file. You can send this log file to 

Bluespring Support for assistance. 
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2. Click Next. The End-User License Agreement screen is displayed.

 
3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Scheduling Service files. 

5. Click Next. The BPM Workspace screen is displayed. 

 
6. In the Workspace server name field, type the name of your Workspace server. 

7. In the Port number field, type the Workspace Service’s Port Number. 

Note:  The port number you enter here should be the same port number you entered 

on the HTTP Server screen in the Workspace Service install 
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8. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 

Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the Scheduling service. 

Note:  By default, the Scheduling Service will connect to the Workspace Service using 

the Local System account. The Local System account does not have permission 

to access the Workspace Service when it is hosted on a remote server. 

9. Click Next. The Runtime Database screen is displayed. 

 
10. From the Available runtime database(s) list, select the Runtime Database that you created in 

the section Creating a Runtime Database. 
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11. Click Next. The HTTP Server screen is displayed.

 
12. In the Hostname field, type the name of your host server. 

13. In the Server Details fields: 

a. Type the port number in the Port number field. The Scheduling Service will listen for 

requests on this port. 

Note:  Port 9000 is the default port used by BPM 5’s services; however, you can change 

the port number if port 9000 is used by another application. 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data. 
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14. Click Next. The Ready to install Bluespring BPM Scheduling Service 5 screen is displayed.

 
15. Click Install. The installation begins. When complete, the Completed the Bluespring BPM 

Scheduling Service 5 Setup Wizard screen is displayed. 

 
16. Click Finish. You installed the Bluespring BPM Scheduling Service 5. 

Verifying the BPM Scheduling Service 5 Installation 

Verify that your installation was successful by checking for errors in the service’s log file or by checking 

the service’s status in the Services utility or both.  
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To check the BPM Scheduling Service installation status in the Services utility, complete the following 

steps: 

1. From the Start menu, select Administrative Tools and then select Services. 

2. In the Services window, select Bluespring Scheduling Service. The status of the selected service 

is displayed as Started under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 
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Installing BPM Process Engine 

The BPM Process Engine is a Windows service that manages the processing of activities and information 

in a solution. 

To install the BPM Process Engine complete the following steps: 

1. Double-click the BPM Process Engine setup file (bpm process engine.msi). The Bluespring BPM 

Process Engine 5 Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry the install, but double-

click the bpm process engine (logfile).bat file to start the install. Using that file 

will generate a detailed installation log file. You can send this log file to 

Bluespring Support for assistance. 
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2. Click Next. The End-User License Agreement screen is displayed. 

 
3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Process Engine files. 

5. Click Next. The BPM Workspace screen is displayed. 

 
6. In the Workspace server name: field, type the name of the server hosting your Workspace 

service. 

7. In the Port number field, type the Workspace Service’s Port Number. 
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Note:  The port number you enter here should be the same port number you entered 

on the HTTP Server screen in the Workspace Service install. 

8. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 

Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the File Monitor service. 

Note:  By default, the Process Engine service will connect to the Workspace Service 

using the Local System account. The Local System account does not have 

permission to access the Workspace Service when it is hosted on a remote 

server. 

9. Click Next. The Runtime Database screen is displayed. 

 
10. From the Available runtime database(s) list, select the Runtime Database that you created in 

the section Creating a Runtime Database. 

11. Click Next. The HTTP Server screen is displayed. 
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12. In the Hostname: field, type the name of your host server. 

13. In the Server Details fields: 

a. Type the port number in the Port number field. The Process Engine Service will listen for 

requests on this port. 

Note:  Port 9000 is the default port used by BPM 5’s services; however, you can change 

the port number if port 9000 is used by another application. 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data. 

14. Click Next. The Ready to install Bluespring BPM Process Engine 5 screen is displayed. 
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15. Click Install. The installation begins. When complete, the Completed the Bluespring BPM 

Process Engine 5 Setup Wizard screen is displayed. 

 
 

16. Click Finish. You installed the Bluespring BPM Process Engine 5 and now you have to activate the 

service for it to properly function. Please see the next section, Activating the BPM Process 

Engine 5 Installation. 

Activating the BPM Process Engine 5 Installation  

When the Process Engine install completes you will be prompted to activate BPM Process Engine 5. To 

activate you will need either your Trial or Full license credentials provided by Bluespring.   

Note: If you do not have Internet access on the server, access the activation website from 

another location to retrieve your activation code. See Appendix F for further instructions. 

To activate your Process Engine, complete the following steps: 

1. In the User ID field of the Activate BPM5 Process Engine window, enter the User ID from the 

license you received from Bluespring. The User ID will be a series of numbers (Example: 1234). 

2. In the Password field, enter the password associated with the User ID you received from 

Bluespring. 

Note: By default, the I want to activate the software over the internet option is selected. 
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3. Click Next. The activation status page is displayed. 

 

Note: Registration is optional. If you do not want to register your copy of the service, skip to 

step 4. 

4. Click Close in the Activate BPM5 Process Engine window. The Activated window is displayed 

indicating you successfully activated BPM5 Process Engine through the internet and now you 

want to start the Process Engine service.  
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5. Click Yes to start the Process Engine Service. You started the Process Engine Service. 

Verifying the BPM Process Engine 5 Installation 

Verify that your installation was successful by checking for errors in the service’s log file or by checking 

the service’s status in the Services utility or both.  

To check for errors in the Bluespring Process Engine log file, complete the following steps: 

1. Navigate to the Process Engine folder. This is the folder you selected as the destination folder in 

step 4 of Installing the BPM Process Engine. 

2. Open the Bluespring Process Engine Service log file (Bluespring.ProcessEngine.log). 

You should not see any errors and see lines similar to the following lines: 

 2010-06-19 07:03:37  Engine: Start [CALLED] 

 2010-06-19 07:03:37  Engine: StartAllPlugins [CALLED] 

To check the installation status in the Services utility, complete the following steps: 

1. From the Start menu, select Administrative Tools and then select Services. 

2. In the Services window, select Bluespring Process Engine. The status of the selected service is 

displayed as Started under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 
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Installing BPM File Monitor Service 

The BPM File Monitor Service is a Windows service used to monitor file shares for file events. When a 

file event occurs, the BPM File Monitor Service will start an instance of a process in BPM. The process 

started will include the Receive File Monitor Event activity and be configured to use the File Monitor 

Service System Resource.  

The File Monitor Service can be installed on the server hosting your other BPM 5 services; however, 

Bluespring recommends installing the service on the server that contains the directory or folder being 

monitored. Network latency may cause undesired results if the File Monitor service is monitoring a 

network folder or directory not available on the File Monitor service’s server. 

To install the BPM File Monitor Service, complete the following steps: 

1. Double-click the BPM File Monitor Service setup file (bpm file monitor service.msi). The 

Bluespring BPM File Monitor 5 Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry, but double-click the 

bpm file monitor service (logfile).bat file to start the install. Using the install file 

will generate a detailed installation log file. You can send this log file to 

Bluespring Support for assistance. 
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2. Click Next. The End-User License Agreement screen is displayed.

 
3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM File Monitor Service files. 

5. Click Next. The BPM Workspace screen is displayed. 

 
6. In the Workspace server name field, type the name of the server hosting your Workspace 

service. 

7. In the Port number field, type the Workspace Service’s Port Number. 
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Note:  The port number you enter here should be the same port number you entered 

on the HTTP Server screen in the Workspace Service install. 

8. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 

Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the File Monitor service. 

Note:  By default, the File Monitor service will connect to the Workspace Service using 

the Local System account. The Local System account does not have permission 

to access the Workspace Service when it is hosted on a remote server. 

9. Click Next. The Ready to install Bluespring BPM File Monitor 5 screen is displayed. 
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10. Click Install. The installation begins. When complete, the Completed the Bluespring BPM File 

Monitor 5 Setup Wizard screen is displayed.

 
11. Click Finish. You installed the Bluespring BPM File Monitor 5. 

Verifying the BPM File Monitor Installation 

Verify that your installation was successful by checking the service’s status in the Services utility.  

To check the installation status in the Services utility, complete the following steps: 

1. From the Start menu, select Administrative Tools and then select Services. 

2. In the Services window, select Bluespring File Monitor. The status of the selected service is 

displayed as Started under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 
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Installing the BPM 5 for SharePoint Service 

The BPM SharePoint Service is a Windows service running on your BPM Server, which enables 

communication between SharePoint and BPM services. 

To install the BPM SharePoint Service, complete the following steps: 

1. Double-click the BPM SharePoint 5 setup file (bpm sharepoint.msi). The Bluespring BPM 

SharePoint 5 Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry the install, but double-

click the bpm sharepoint (logfile).bat file to start the install. Using that file will 

generate a detailed installation log file. You can send this log file to Bluespring 

Support for assistance. 
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2. Click Next. The End-User License Agreement screen is displayed. 

 
 

3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM SharePoint Service files. 

5. Click Next. The BPM Workspace screen is displayed 

 
6. In the Port number field, type the Workspace Service’s Port Number. 

Note:  The port number you enter here should be the same port number you entered 

on the HTTP Server screen in the Workspace Service install. 

7. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 
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Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the SharePoint service. 

Note:  By default, the SharePoint service will connect to the Workspace Service using 

the Local System account. The Local System account does not have permission 

to access the Workspace Service when it is hosted on a remote server. 

8. Click Next. The Runtime Database screen is displayed 

 
9. From the Available runtime database(s) list, select the Runtime Database that you created in 

the section Creating a Runtime Database. 

10. Click Next. The HTTP Server screen is displayed 
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11. In the Hostname field, type the name of your host server. 

12. In the Server Details fields: 

a. Type the port number in the Port number field. The Process Engine Service will listen for 

requests on this port. 

Note:    Port 9000 is the default port used by BPM 5’s services; however, you can change    

the port number if port 9000 is used by another application. 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data.    

13. Click Next. The Ready to Install Bluespring BPM SharePoint 5 screen is displayed.

 



 

 

57   

14. Click Install. The installation begins. When complete, the Completed the Bluespring BPM 

SharePoint 5 Setup Wizard screen is displayed. 

 
15. Click Finish. You installed the Bluespring BPM 5 for SharePoint Service. 

Verifying the BPM 5 for SharePoint Installation 

Verify that the installation was successful by checking the service’s status in the Services utility.  

To check the installation status in the Services utility, complete the following steps: 

1. From the Start menu, select Administrative Tools and then select Services. 

2. In the Services window, select Bluespring SharePoint Service. The status of the selected service 

is displayed as Started under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 

 

Deploying the SharePoint Solution 

After completing the installation of the Bluespring BPM 5 for SharePoint Service, you must Add the 

SharePoint Solution package to the SharePoint solution store and Deploy it to your SharePoint site or all 

SharePoint web applications.  

Note: The steps below should be completed only by or under the supervision of your 

SharePoint Administrator. 
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The SharePoint Solution Package (.wsp) is located in the wsp folder in the BPM 5 for SharePoint 

Destination folder. 

Note: This folder is the destination folder that you selected in Step 4 of the Installing the BPM 

5 for SharePoint Service steps. 

 

To deploy the SharePoint Solution Package, complete the following steps: 

1. Copy the SharePoint Solution Package, Bluespring.SharePoint.wsp to your SharePoint server(s) 

2. Use the SharePoint stsadm command-line tool to Add the SharePoint Solution, 

Bluespring.SharePoint.wsp, to the SharePoint solution store. For more information, see: Add-

SPSolution 

3. Use the SharePoint stsadm command-line tool or Central Administration to Deploy the 

SharePoint Solution, bluespring.sharepoint.wsp to a site. For more information, see: Deploy 

Farm Solutions 

  

http://technet.microsoft.com/en-us/library/ff607552.aspx
http://technet.microsoft.com/en-us/library/ff607552.aspx
http://technet.microsoft.com/en-us/library/cc262995.aspx#DeployFarmSolutions
http://technet.microsoft.com/en-us/library/cc262995.aspx#DeployFarmSolutions
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Installing CRM 5 

The CRM Monitor Service is used to monitor events and actions within Microsoft Dynamics CRM 4.0. The 

monitor will start a process when following a CRM event and pass data about the entity to the process. 

To install BPM CRM Monitor Service, complete the following steps: 

1. Double-click the BPM Designer 5 setup file (bpm crmservice.msi). The Bluespring BPM CRM 5 

Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry, but double-click the bpm 

 crm service (logfile).bat file to start the install. Using the install file will generate a 

 detailed installation log file. You can send this log file to Bluespring Support for 

 assistance. 

 

2. Click Next. The End-User License Agreement screen is displayed. 

3. After reading the agreement, select I accept the terms in the License Agreement check box. 

4. Click Next. The Destination Folder screen is displayed. 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Designer files. 

5. Click Next. The BPM Workspace screen is displayed. 

6. In the Port number field, type the Workspace Service’s Port Number. 

Note:  The port number you enter here should be the same port number you entered 

on the HTTP Server screen in the Workspace Service install. 

7. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 

Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the SharePoint service. 

Note:  By default, the CRM service will connect to the Workspace Service using the 

Local System account. The Local System account does not have permission to 

access the Workspace Service when it is hosted on a remote server. 

8. Click Next. The HTTP Server screen is displayed. 

 

9. In the Hostname field, type the name of your host server. 

10. In the Server Details fields: 
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a. Type the port number in the Port number field. The Process Engine Service will listen for 

requests on this port. 

Note:    Port 9000 is the default port used by BPM 5’s services; however, you can change    

the port number if port 9000 is used by another application. 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data.    

11. Click Next. The Ready to Install Bluespring BPM CRM 5 screen is displayed. 

12. Click Install. The installation begins. When complete, the Completed the Bluespring BPM CRM 5 

Setup Wizard screen is displayed. 

13.  Click Finish. You installed the Bluespring BPM SharePoint 5. 

Verifying the BPM CRM 5 Installation 

Verify that the installation was successful by checking the service’s status in the Services utility.  

To check the installation status in the Services utility, complete the following steps: 

1. From the Start menu, select Administrative Tools and then select Services. 

2. In the Services window, select Bluespring CRM 5. The status of the selected service is displayed 

as Started under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 

 

  



 

 

61   

Installing BPM Designer 5 

The BPM Designer 5 is an application used to design and configure process solutions. It is typically used 

by Business and Process Analysts.  

To install the BPM Designer 5, complete the following steps: 

1. Double-click the BPM Designer 5 setup file (bpm designer.msi). The Bluespring BPM Designer 5 

Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry, but double-click the 

bpm designer (logfile).bat file to start the install. Using the install file will 

generate a detailed installation log file. You can send this log file to Bluespring 

Support for assistance. 

 



 

 

62   

2. Click Next. The End-User License Agreement screen is displayed.

 
3. After reading the agreement, select I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Designer files. 

5. Click Next. The Ready to Install Bluespring BPM Designer 5 screen is displayed. 
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6. Click Install. The installation process begins. When complete, the Completed the Bluespring 

BPM Designer 5 Setup Wizard screen is displayed.

 
7. Click Finish. You installed the Bluespring BPM Designer 5. 

Verifying the BPM Designer 5 Installation 

Verify that the installation was successful by opening BPM Designer 5 and logging into your workspace. 

To open BPM Designer 5 and connect to a workspace, complete the following steps: 

1. From the Start menu, click All Programs. The All Programs menu is displayed. 

2. Click Bluespring BPM 5. The list of installed BPM 5 applications is displayed. 

3. Click BPM Designer 5. BPM Designer 5 opens and the Connect to Workspace window is 

displayed. 

4. Click Workspaces. The Add/Remove Workspace window is displayed. 

5. Click Add. The Add Workspace window is displayed. 

6. Type the following: 

a. The name of the Workspace server in the Workspace server name field 

b. The port number in the Port field 

c. The appropriate protocol from the Protocol options 

Note:  The Workspace server name, port number, and the protocol you enter here 

should be same as those you entered on the HTTP Server screen in the 

Workspace Service install. 

7. Click OK. 

8. Click Close.  
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9. From the Connect to a Workspace drop-down list, select your Workspace. 

10. Click Connect. The BPM Designer workspace is displayed. 

You successfully installed BPM Designer 5 and connected to a workspace. 
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Installing the BPM 5 for CRM 2011 Service 

The BPM CRM 2011 Service is a Windows service running on your BPM Server, which enables 

communication between CRM 2011 and BPM services. 

To install the BPM CRM 2011 Service, complete the following steps: 

1. Double-click the BPM 5 for CRM 2001 setup file (bpm crm 2011 service.msi). The Bluespring 

BPM 5 for CRM 2011 Setup Wizard is displayed. 

Note:  If you encounter an error during the install, please retry the install, but double-

click the bpm sharepoint (logfile).bat file to start the install. Using that file will 

generate a detailed installation log file. You can send this log file to Bluespring 

Support for assistance. 

 



 

 

67   

2. Click Next. The End-User License Agreement screen is displayed. 

 
 

3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed.

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM SharePoint Service files. 

5. Click Next. The BPM Workspace screen is displayed 

 
6. In the Port number field, type the Workspace Service’s Port Number. 

Note:  The port number you enter here should be the same port number you entered 

on the HTTP Server screen in the Workspace Service install. 

7. Select the Protocol (HTTP or HTTPS) that is used by the Workspace Service. 



 

 

69   

Optionally, to connect as another user, complete the following steps: 

 Select the Connect as another user checkbox. 

 Type the User name and Password of a domain user that is a member of the Local 

Administrators group on the server hosting the SharePoint service. 

Note:  By default, the CRM 2011 service will connect to the Workspace Service using 

the Local System account. The Local System account does not have permission 

to access the Workspace Service when it is hosted on a remote server. 

8. Click Next. The Runtime Database screen is displayed 

 
9. From the Available runtime database(s) list, select the Runtime Database that you created in 

the section Creating a Runtime Database. 

10. Click Next. The HTTP Server screen is displayed 



 

 

70   

 
11. In the Hostname field, type the name of your host server. 

12. In the Server Details fields: 

a. Type the port number in the Port number field. The Process Engine Service will listen for 

requests on this port. 

Note:    Port 9000 is the default port used by BPM 5’s services; however, you can change    

the port number if port 9000 is used by another application. 

b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data. 

13. Click Next. The Ready to Install Bluespring BPM 5 for CRM 2011 screen is displayed. 
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14. Click Install. The installation begins. When complete, the Completed the Bluespring BPM 

SharePoint 5 Setup Wizard screen is displayed. 

 
15. Click Finish. You installed the Bluespring BPM 5 for CRM 2011 Service. 

Verifying the BPM 5 for CRM 2011 Installation 

Verify that the installation was successful by checking the service’s status in the Services utility.  

To check the installation status in the Services utility, complete the following steps: 

3. From the Start menu, select Administrative Tools and then select Services. 

4. In the Services window, select Bluespring CRM 2011 Service. The status of the selected service 

is displayed as Started under the Status column. 

Note:  If the installation is successful, the status will be displayed as Started. 

 

Deploying the CRM 2011 Managed Solution 

After completing the installation of the Bluespring BPM 5 for CRM 2011 Service, you must Import the 

CRM 2011 Managed Solution package to your CRM 2011 Organization. 

Note: The steps below should be completed in consultation with or under the supervision of 

your CRM 2011 Administrator. 

To import the Managed Solution to your CRM 2011 Organization, use the Bluespring BPM for CRM 

Solution Tool 
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1. Open Start -- > All Programs -- > Bluespring BPM 5 -- > BPM for CRM Solution Tool. The BPM for 

CRM Solution Tool is displayed 
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2. In the URL field, type the URL for your CRM 2011 deployment 

3. In the Organization Name field, type the Organization Name for your CRM 2011 deployment 

displayed. 

Note:  You can find the Organization Name in CRM 2011 by going to Settings -- > 

Customizations -- > Developer Resources 
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4. Select a User to authenticate to your CRM 2011 deployment  

Note:  the User specified must be assigned the Deployment Administrator role in CRM 

2011 

a. Use default credentials: <Domain>\<Username> 

b. Connect as another user 

i. In the Username field, type the Username you wish to connect to your CRM 

2011 deployment 

ii. In the Password field, type the Password for the Username provided 

Note:  You may select Show password to verify the password provided 

5. Select your Action for the CRM Managed Solution 

a. Import managed solution into Organization: imports the Managed Solution: 

BluespringCrm2011 to the specified deployment of CRM 2011, for all current entities in 

CRM 2011 

b. Generate managed solution file for later import: creates a zip file to the specified 

location, which can then be manually imported within CRM 2011 

i. Specify a location to store the zip file 

http://msdn.microsoft.com/en-us/library/gg197626.aspx
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1. Click on the ellipsis, . The Save As screen is displayed 

 
2. Navigate to a location, enter a File name and click Save 

Note:  You can then Import the Managed Solution at any time within 

CRM 2011 via Settings -- > Customizations -- > Solutions -- > 

Import. 

6. Click [Next] to complete the Action selected. 

Verifying the BPM 5 for CRM 2011 Managed Solution 

Verify that the Managed Solution was successfully imported to CRM 2011 by opening CRM 2011 and 

located the Solution. 

1. Open a browser and navigate to your CRM 2011 deployment 

2. Click Customization 
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3. Click Solutions. The Solutions store is displayed 

 
4. Confirm the Solution: BluespringCrm2011 appears in the Managed Solutions view 
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Installing BPM Admin 5 

The BPM Admin 5 is an application that is used to monitor instances of process solutions. It is used by 

Bluespring administrators.  

You use BPM Admin to: 

 Monitor process instances in a runtime database 

 Restart a process or an activity 

 Cancel a process or an activity 

 View process status 

 View subprocesses 

 View data item values before and after activity execution 

 View activity execution log with informational, warning, and error messages 

To install the BPM Admin 5, complete the following steps: 

1. Double-click the BPM Admin 5 setup file (bpm admin.msi). The Bluespring BPM Admin 5 Setup 

Wizard is displayed. 

Note: If you encounter an error during the install, please retry, but double-click the 

bpm admin (logfile).bat file to start the install. Using the install file will generate 

a detailed installation log file. You can send this log file to Bluespring Support for 

assistance. 
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2. Click Next. The End-User License Agreement screen is displayed. 

 
3. After reading the agreement, select I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed. 

 

Note:  If you want to choose a different destination folder, click Change and select the 

folder where you want to store the BPM Admin files. 

5. Click Next. The Ready to Install Bluespring BPM Admin 5 screen is displayed. 
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6. Click Install. The installation begins. When complete, the Completed the Bluespring BPM Admin 

5 Setup Wizard screen is displayed. 

 
7. Click Finish. You installed the BPM Admin 5. 

Verifying the BPM Admin 5 Installation 

Verify that the installation was successful by opening BPM Admin 5. 

1. From the Start menu, click All Programs. The All Programs menu is displayed. 

2. Click Bluespring BPM 5. The list of installed BPM 5 applications is displayed. 

3. Click BPM Admin 5. BPM Admin 5 opens. 

You successfully completed the installation of Bluespring BPM5. 

 Note: In order to save your Workspace in BPM Admin, create a console with the Bluespring 

 Admin Snap-in. Please see Appendix D for further instructions. 
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Installing the Command Service with BPM5 

Installing the Command Service 

The Bluespring Command Service is a stand-alone Windows Communication Foundation (WCF) Service 
that exposes the Command Prompt as a Web Service, allowing you to use Bluespring BPM5's Invoke Web 
Service Activity to initiate Batch Files or other Command Prompt commands. 
 
To install the Bluespring Command Service, complete the following steps:  

1. Double-click the BPM command service setup file (bpm command service.msi). The Bluespring 
BPM Task Service 5 Setup Wizard is displayed. 
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2. Click Next. The End-User License Agreement screen is displayed. 

 
3. After reading the agreement, select the I accept the terms in the License Agreement check box. 
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4. Click Next. The Destination Folder screen is displayed. 

 
Note: If you want to choose a different destination folder, click Change and select the folder 
where you want to store the BPM Task Service files. 

5. Click Next. The HTTP Server screen is displayed. 

 
6. In the Hostname field, type the name of the host server. 

7. In the Server Details fields type the following: 

a. The port number in the Port number field. The Notification Service will listen for 

requests on this port. 

Note:  Port 9000 is the default port used by BPM 5’s services; however, you can change 

the port number if port 9000 is used by another application. 
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b. Select HTTP from the Protocol options. You select HTTP to transmit unencrypted data 

and HTTPS to transmit encrypted data. 

8. Click Next. The Ready to install Bluespring BPM Command Service 5 screen is displayed. 

 
9. Click Install. The Installation begins. When the installation is completed, the Completed the 

Bluespring BPM Task Service 5 Setup Wizard screen is displayed. 

 
10. Click Finish. You installed the Bluespring Command Service. 
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Appendix A: Security Note: Windows Server 2008 User Account Control 

You may see a User Account Control window may appear when installing on Server 2008. If you do not 

see the window, then your IT department has disabled this feature and you can ignore this section. 

User Account Control windows are meant to provide additional security for Microsoft Windows. Prior to 

changes being made to your computer, an unauthorized application must receive authorization to do so. 

In order to proceed with installation, you must click Yes to authorize the application.  

A User Account Control window may resemble the image below: 
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Appendix B: Windows Firewall and SQL Server Configuration 

Bluespring recommends the service and applications be installed on one server and the workspace and 

runtime databases be installed on another server dedicated to hosting Microsoft SQL Server. Because 

the services and applications will be installed on a separate server, you will need to confirm the 

following Windows Firewall and SQL Server settings are correct: 

 Open TCP port 1433 in Windows Firewall on the Microsoft SQL Server   

 Open TCP port 9000 in Windows Firewall on Bluespring Server(s)  

 Start SQL Browser Service on SQL Server 

 Enable TCP/IP in SQL Server Configuration Manager  

Opening TCP Port 1433 in Windows Firewall on the Microsoft SQL Server 

For BPM Designer, BPM Admin, and the services to access the database from the remote computer or 

server, TCP port 1433 needs to be open in Windows Firewall on Server 2008. By default, Windows 

Firewall blocks this port, which is SQL Server’s default port for accepting connection. The port number 

can be changed, so confirm with your database administrators that the port number being used is 1433 

or note the port being used by the database. 

If the SQL and BPM5 services and applications are on one server then you do not need to open the port, 

because all of the communication between the components happens behind the computer’s firewall. 

To open the TCP port 1433 in Windows Firewall on Server 2008, complete the following steps: 

1. From the Start menu, click Control Panel.  

2. Click System and Security.  

3. Click Windows Firewall. The Windows Firewall screen is displayed. 

4. Click Advanced Settings. The Windows Firewall with Advanced Security window opens. 

 
5. Click Inbound Rules. The Inbound Rules are displayed in the center pane. 
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6. From the Actions on the right-side of the window, click the New Rule. The New Inbound Rule 

Wizard window is displayed. 

7. On the Rule Type tab, select the Port option, and then click Next. The Protocol and Ports tab is 

displayed.  

8. Confirm the TCP option is selected. If not selected, select TCP instead of UDP. 

9. In the specific port field type 1433, and then click Next. The options for the Action tab are 

displayed.  

10. Confirm the Allow the connection option is selected. If not selected, select that option. 

11. Click Next. The Profile tab is displayed. 

12. Click Next. The Name tab is displayed. 

13. In the Name field type SQL Server. The Description is optional.  

14. Once you are finished typing the Name and, optionally, the Description, click Finish. You opened 

the TCP port 1433. 

Opening TCP port 9000 in Windows Firewall on Bluespring Server(s)  

By default, the BPM5 service installs assume you want to install them to port 9000. You should only 

change this option if the port is taken by another application; however, Bluespring also recommends 

each server be dedicated to BPM5 for optimal processing. If the port is blocked, which it is by default, 

then you will not be able to communicate with the Bluespring BPM5 Services from a remote computer.  

If all of the BPM5 services and applications are on one server then you do not need to open the port, 

because all of the communication between the components happens behind the firewall.  

To open TCP port 9000 in Windows Firewall on Server 2008, complete the following steps: 

1. From the Start menu, click Control Panel.  

2. Click System and Security.  

3. Click Windows Firewall. The Windows Firewall screen is displayed. 

4. Click Advanced Settings. The Windows Firewall with Advanced Security window opens. 
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5. Click Inbound Rules. The Inbound Rules are displayed in the center pane. 

6. From the Actions on the right-side of the window, click New Rule. The New Inbound Rule 

Wizard window opens. 

7. On the Rule Type tab, select the Port option, and then click Next. The Protocol and Ports tab is 

displayed.  

8. Confirm the TCP option is selected. If not selected, select TCP instead of UDP. 

9. In the specific port field type 9000, and then click Next. The options for the Action tab are 

displayed.  

10. Confirm the Allow the connection option is selected. If not selected, select that option. 

11. Click Next. The Profile tab is displayed. 

12. Click Next. The Name tab is displayed. 

13. In the Name field type Bluespring. The Description is optional.  

14. Once you are finished typing the Name and, optionally, the Description, click Finish. You opened 

the TCP port 9000. 

Starting SQL Server Browser Service on SQL Server 

When you start the SQL Server Browser, it supplies client computers with SQL Server connection 
information and is required when the Bluespring services and applications are not hosted on the SQL 
Server. 
 
To start the SQL Server Browser service, complete the following steps: 
 

1. On your SQL Server hosting the workspace and runtime databases, open Services. 

 Note:   One way to open Services is to go to Windows Start > Control Panel > System 

and Security > Administrative Tools > Services.  

 
2. Right-click SQL Server Browser. A drop-down list will be displayed.  

3. From the drop-down list select Start. The SQL Server Browser service is now started. 
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Enabling TCP/IP in SQL Server Configuration Manager 

Finally, you will need to enable TCP/IP for the SQL Server instance hosting the workspace and runtime 

databases. This feature is required when the Bluespring services and applications are not hosted—as 

recommended—on the SQL Server. 

To enable TCP/IP in SQL Server Configuration Manager, complete the following steps: 

1. From the Start menu, click Microsoft SQL Server 2008 R2.  

Note: Similar steps apply for Microsoft SQL Server 2005 and Microsoft SQL Server 

2008. 

2. Click Configuration Tools. 

3. Click SQL Server Configuration Manager. The SQL Server Configuration Manager window opens. 

 
4. Expand the SQL Server Network Configuration. A list of SQL Server instances is listed.  

5. Click the Protocols for <Bluespring Instance> where <Bluespring Instance> is the SQL Server 

instance hosting your workspace and runtime databases. The protocols for that instance are 

displayed to the right. 

Note:  For SQL Server 2005, you need to expand the SQL Server 2005 Network 

Configuration. 

Note:  In the above screenshot the instance is called MSSQLSERVER. 

6. Right-click the TCP/IP protocol, and then click Enable. The following Warning window will 

appear telling you that you will need to restart the SQL Server service. 

 
7. Click OK. You enabled the TCP/IP protocol and now need to restart the SQL Server service for 

the change to become active. 

8. Click SQL Server Services. 

9. Right-click the SQL Server (<Bluespring Instance>) where <Bluespring Instance> is the SQL 

Server instance hosting your workspace and runtime database. 
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10. Click Restart. The service restarts and the TCP/IP protocol change is not active. 

You completed the necessary server changes to allow the Bluespring services and applications to 

connect to a remote SQL Server. 
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Appendix C: Creating a Console with the Bluespring Admin Snap-in 

Creating a custom console with the Bluespring BPM Admin snap-in will allow you to manage common 

Windows and Bluespring features from a single interface. Additionally, the Bluespring BPM Admin added 

to your custom console will remember the workspace, so you do not have to enter the workspace each 

time you open the console. 

1. Click Window Start > Run. The Run window is displayed. 

2. Type MMC in the Open field. 

3. Click OK. The new console window is displayed. 

4. From the File menu, click Add/Remove Snap-in from the drop-down list. The Add or Remove 

Snap-ins window is displayed. 

5. Select Bluespring BPM Admin from the Available Snap-ins field. 

6. Click Add. The Workspace Connection window is displayed. 

7. Type the name of the server hosting your workspace in the Workspace server name field. 

8. Type the appropriate port number in the Port field. 

9. Select HTTP or HTTPS from the Protocol field. 

Note: Choose HTTPS, if they require secure connections 

10. Click OK. You added the Bluespring BPM Admin snap-in to the console. 

Note: If you want to extend the options on the console, Bluespring recommends adding the 

Event Viewer and Server Manager snap-ins. The Event Viewer allows you to view the event logs 

for the Bluespring services and the standard Windows logs. The Server Manager is 

recommended, because it provides access to the Message Queues and other features installed 

on this server. 

11. Click OK. 

12. From the File menu, click Options. The Options window is displayed. 

13. Type the new name in the Console field. 

14. From the Console mode field, select User mode - full access to prevent a reoccurring window 

that will prompt you to save. 

15. Select the Do not save changes to this console check box. 

16. Click OK.  

17. From the File menu, click Save. The Save As window is displayed. 

18. Save the console to the location of your choice. You created a console that uses the Bluespring 

BPM Admin snap-in.  
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Appendix D: Activating your copy of BPM Designer  

Bluespring Software will provide you with one of two types of licenses, Trial or Full. With the Trial 

license, you will have a designated number of days to use the software before the license expires. The 

trial period starts when the license is activated and the license cannot be used again once activated. 

You can activate BPM Designer via the Internet or the activation website. 

Activating through the Internet 

To activate the BPM Designer Licensing, complete the following steps: 

1. Open BPM Designer. The Activate BPM Designer 5.1 window is displayed when one of the 

following conditions is true:  

a. You open BPM Designer on your computer for the first time. 

b. You have been using a Trial license and you decide to activate Designer with a Full 

license. 

c. Your license file is invalid. 

2. In the User ID field, enter the User ID from the license you received from Bluespring. The User ID 

will be a series of numbers (Example: 1234). 

3. In the Password field, enter the password associated with the User ID you received from 

Bluespring. 

Note: By default, the I want to activate the software over the internet option is selected. 

4. Click Next. The activation status page is displayed. 

5. Click Register Now to register your copy of BPM Designer. The Registration Information window 

is displayed. 

Note: Registration is optional. If you do not want to register your copy of BPM Designer, skip to 

step 8. 

6. Type the appropriate information into the corresponding fields. 

7. Click Register. The Registration window is displayed, notifying you that the registration is 

complete. 

8. Click OK to close the Registration window.  

9. Click Close in the Activate BPM Designer window. BPM Designer automatically opens. You 

successfully activated BPM Designer through the internet. 

Activating through the Activation Website 

To activate the software through the activation website, complete the following steps: 

1. Open BPM Designer. The Activate BPM Designer 5.1 window is displayed when one of the 

following conditions is true:  

a. You open BPM Designer on your computer for the first time. 
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b. You have been using a Trial License and you decide to activate Designer with a Full 

License. 

c. Your license file is invalid. 

2. Type the appropriate information into the User ID field, enter the User ID from the license you 

received from Bluespring. The User ID will be a series of numbers (Example: 1234). 

3. In the Password field, enter the password associated with the User ID you received from 

Bluespring. 

4. Select the I want to activate the software through the activation website option. 

5. Click Next. The Activation Code retrieval steps are displayed. 

6. Complete steps one and two provided on the page 

Note: Ensure that your computer as internet access prior to the completion of these steps. 

7. Click the link provided in step three. The website will appear in a new window. 

8. Enter the verification number in the vacant fields of step two on the activation website. 

9. Click Submit. A new page will appear displaying both the verification number entered and the 

activation code. 

Note: Registration is optional. If you want to register click Register Now in the Activate BPM 

Designer 5.0 window. 

10. Once you retrieve the Activation Code from the activation website, enter the code into the 

Activate BPM Designer 5.0 window’s vacant fields provided below step four. 

11. Click Next. The activation status page is displayed. 

Note: Registration is optional, if you want to register click Register Now in the Activate BPM 

Designer 5.0 window. 

12. Click Close. BPM Designer 5 automatically opens. You successfully activated BPM Designer 

through the activation website. 
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Appendix E: Activating your BPM Process Engine through the Activation Website 

To activate your BPM Process Engine through the activation website, complete the following steps: 

1. Type the appropriate information into the User ID field, enter the User ID from the license you 

received from Bluespring. The User ID will be a series of numbers (Example: 1234). 

2. In the Password field, enter the password associated with the User ID you received from 

Bluespring. 

3. Select the I want to activate the software through the activation website option. 

4. Click Next. The Activation Code retrieval steps are displayed. 

5. Complete steps one and two provided on the page 

Note: Ensure that your computer as internet access prior to the completion of these steps. 

6. Click the link provided in step three. The website will appear in a new window. 

7. Enter the verification number in the vacant fields of step two on the activation website. 

8. Click Submit. A new page will appear displaying both the verification number entered and the 

activation code. 

Note: Registration is optional. If you want to register click Register Now in the Activate BPM5 

Process Engine window. 

9. Once you retrieve the Activation Code from the activation website, enter the code into the 

Activate BPM Designer 5.0 window’s vacant fields provided below step four. 

10. Click Next. The activation status page is displayed. 

6. Click Close in the Activate BPM5 Process Engine window. You successfully activated BPM5 

Process Engine through the internet and now you want to start the service. The Activated 

window is displayed. 

 
7. Click Yes to start the Process Engine Service. You started the Process Engine Service. 
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Appendix F: Manual Database Setup for Bluespring BPM5 

BPM5 supports organizations that require databases and SQL accounts be created manually before 

executing the BPM5 installs. As documented in this install guide, you can create the accounts while 

setting up the Workspace install, and the runtime account can be created automatically with an auto-

generated password during the runtime database install (runtimedb.exe). 

If your organization requires that the databases and SQL accounts be created manually, please contact 

Bluespring Support: support@bluespringsoftware.com or (877) 871-9566, to review the steps involved 

in creating databases before installing Bluespring BPM5. 

  

mailto:support@bluespringsoftware.com
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Appendix G: Refreshing a BPM5 Environment 

Occasionally, a BPM5 environment may need to be “refreshed,” which means you will stop and then 

start the core BPM5 services. The services should be stopped and restarted in a specific order as 

discussed in this section of the guide.  

You should refresh your environment when connections to the database server are disrupted. For 

example, if the database server is configured to failover to a mirrored server, then your BPM5 services 

will continue running. However, you should still refresh your services to confirm the connections are 

current and to reduce potential issues with future processing. 

To refresh your BPM5 environment, please complete the following steps manually: 

1. On your BPM5 server, open Server Manager and access Services. 

2. Stop the Bluespring Notification Service. 

3. Stop the Bluespring Scheduling Service. 

4. Stop the Bluespring Process Engine Service. 

5. Stop the Bluespring Task Service. 

6. Stop the Bluespring Workspace Service. 

7. Start the Bluespring Workspace Service. 

8. Start the Bluespring Task Service. 

9. Start the Bluespring Process Engine Service. 

10. Start the Bluespring Scheduling Service. 

11. Start the Bluespring Notification Service. 

You successfully refreshed your BPM5 environment. 

 

NOTE: By following this installation manual and subsequent restart instructions, Bluespring BPM should 

perform as intended. However, it is recommended that Organizations put the server Bluespring resides 

on a reboot schedule commensurate with any firmware or OS updates, environment changes and/or 

standard Sever maintenance. 

 


